
QGIS Application - Issues

# Tracker Status Priority Subject Assignee Updated# Tracker Status Priority Subject Assignee Updated

21005 Feature request Rejected High How to create point along road centre line with offset value Alexandre Neto 2019-01-15 05:12 PM

21005 Feature request Rejected High How to create point along road centre line with offset value Alexandre Neto 2019-01-15 05:12 PM

21004 Feature request Closed High How to create point along road centre line with offset value Alexandre Neto 2019-01-15 05:11 PM

21004 Feature request Closed High How to create point along road centre line with offset value Alexandre Neto 2019-01-15 05:11 PM

20896 Bug report Closed High Qgis crash 2018-12-31 06:32 PM

20896 Bug report Closed High Qgis crash 2018-12-31 06:32 PM

20832 Bug report Rejected Normal EnMAP-box        Interactive Visualization of Vegetation Reflection Models            Flashback 2018-12-18 10:01 AM

20832 Bug report Rejected Normal EnMAP-box        Interactive Visualization of Vegetation Reflection Models            Flashback 2018-12-18 10:01 AM

20023 Bug report Closed Normal Qgis ver 3.2.3 can't install Semi Automatic Classification plugin 2018-10-05 09:47 AM

20023 Bug report Closed Normal Qgis ver 3.2.3 can't install Semi Automatic Classification plugin 2018-10-05 09:47 AM

20009 Feature request Open Normal Coordinate capture plugin coordinate precision 2018-10-04 01:20 AM

20009 Feature request Open Normal Coordinate capture plugin coordinate precision 2018-10-04 01:20 AM

20000 Bug report Open Normal Coordinate Capture plugin geographic coordinate issue 2018-10-04 10:07 PM

20000 Bug report Open Normal Coordinate Capture plugin geographic coordinate issue 2018-10-04 10:07 PM

19889 Feature request Open Normal Enable Snapping in Coordinate Capture 2018-09-19 08:31 AM

19889 Feature request Open Normal Enable Snapping in Coordinate Capture 2018-09-19 08:31 AM

19888 Bug report Open Normal Coordinate Capture does not use datum transformation 2018-09-19 08:29 AM

19888 Bug report Open Normal Coordinate Capture does not use datum transformation 2018-09-19 08:29 AM

19741 Bug report Closed Normal GpxSegmentImporter crash when ignoreShapeEncoding change value 2018-08-31 04:19 PM

19741 Bug report Closed Normal GpxSegmentImporter crash when ignoreShapeEncoding change value 2018-08-31 04:19 PM

19415 Bug report Closed Normal Shortest Path in Qgis 2.18 2019-02-24 10:32 AM

19415 Bug report Closed Normal Shortest Path in Qgis 2.18 2019-02-24 10:32 AM

19352 Bug report Closed Normal DIGITIZONG TOOLS PLUGIN 2018-07-06 09:34 PM

19352 Bug report Closed Normal DIGITIZONG TOOLS PLUGIN 2018-07-06 09:34 PM

19200 Bug report Closed High Qgis 2.18.20 crashing when exporting mbtiles 2018-06-15 04:18 PM

19200 Bug report Closed High Qgis 2.18.20 crashing when exporting mbtiles 2018-06-15 04:18 PM

19146 Bug report Closed High Semi-Automatic classification plugin cierra Qgis 3 cdavila - 2018-06-08 02:07 AM

19146 Bug report Closed High Semi-Automatic classification plugin cierra Qgis 3 cdavila - 2018-06-08 02:07 AM

19044 Bug report Closed Normal Everytime error 2018-05-28 03:10 PM

19044 Bug report Closed Normal Everytime error 2018-05-28 03:10 PM

18972 Bug report Closed Normal Crash after trying to activate "Digitizing Tools" Plugin Bence Vágvölgyi 2018-05-17 11:02 PM

18972 Bug report Closed Normal Crash after trying to activate "Digitizing Tools" Plugin Bence Vágvölgyi 2018-05-17 11:02 PM

18504 Bug report Closed Normal Qgis crash when info over geometry was cliccked 2018-04-09 04:42 AM

18504 Bug report Closed Normal Qgis crash when info over geometry was cliccked 2018-04-09 04:42 AM

18216 Bug report Closed Normal Error 2018-02-27 12:36 PM

18216 Bug report Closed Normal Error 2018-02-27 12:36 PM

18170 Bug report Closed High QGIS crashes when makeGraph is called. 2018-05-16 01:17 PM

18170 Bug report Closed High QGIS crashes when makeGraph is called. 2018-05-16 01:17 PM

18128 Bug report Closed Normal Geometry Checker "C++ Core Plugin" can't save errors as geopackage 2018-02-21 05:41 PM

18128 Bug report Closed Normal Geometry Checker "C++ Core Plugin" can't save errors as geopackage 2018-02-21 05:41 PM

17135 Feature request Open Normal CGAL in QGIS 2017-09-13 06:08 PM

17135 Feature request Open Normal CGAL in QGIS 2017-09-13 06:08 PM

17073 Feature request Closed Normal Use the Map extent custom widget for the "Download OpenStreetMap Data" dialog 2017-10-16 10:53 AM

17073 Feature request Closed Normal Use the Map extent custom widget for the "Download OpenStreetMap Data" dialog 2017-10-16 10:53 AM

15664 Bug report Closed Severe/Regression Dxf2shp Converter crash in 2.14 2017-01-02 02:00 AM

15664 Bug report Closed Severe/Regression Dxf2shp Converter crash in 2.14 2017-01-02 02:00 AM

14541 Bug report Closed Normal Statistics Panel shows empty value if field name include spaces 2016-03-28 05:28 PM

14541 Bug report Closed Normal Statistics Panel shows empty value if field name include spaces 2016-03-28 05:28 PM

12021 Feature request Closed Normal Remove SPIT plugin 2016-05-24 01:08 PM

12021 Feature request Closed Normal Remove SPIT plugin 2016-05-24 01:08 PM

11803 Feature request Rejected High Plugins and lack of character encoding. 2014-12-07 12:32 PM

11803 Feature request Rejected High Plugins and lack of character encoding. 2014-12-07 12:32 PM

10790 Bug report Closed Normal OpenStreetMap plugin only loads 32 bits numbers ID, then start with negative numbers 2018-01-16 07:04 AM

10790 Bug report Closed Normal OpenStreetMap plugin only loads 32 bits numbers ID, then start with negative numbers 2018-01-16 07:04 AM

10459 Bug report Closed Normal Clicking the georeferencer plugin doesn't result in any reaction of QGIS 2017-03-08 08:50 AM

10459 Bug report Closed Normal Clicking the georeferencer plugin doesn't result in any reaction of QGIS 2017-03-08 08:50 AM

10047 Bug report Closed Normal DXF2SHP Plugin doesn't include elevation of polyline 2017-01-02 02:00 AM

10047 Bug report Closed Normal DXF2SHP Plugin doesn't include elevation of polyline 2017-01-02 02:00 AM

9780 Bug report Closed Severe/Regression Road graph plugin broken 2014-03-17 09:51 AM

9780 Bug report Closed Severe/Regression Road graph plugin broken 2014-03-17 09:51 AM

9700 Bug report Closed Normal Georeferencer locks up QGIS 2014-03-05 12:32 AM

9700 Bug report Closed Normal Georeferencer locks up QGIS 2014-03-05 12:32 AM

9565 Bug report Closed High Dxf2Shp converter plugin does not generate any output with the provided input file 2014-10-30 11:48 AM

9565 Bug report Closed High Dxf2Shp converter plugin does not generate any output with the provided input file 2014-10-30 11:48 AM

9505 Bug report Closed High qgis crash on TIN interpolation of curve line 2014-02-12 03:14 AM

9505 Bug report Closed High qgis crash on TIN interpolation of curve line 2014-02-12 03:14 AM

9500 Bug report Closed Normal Wrong list of "result entities ID" after a spatial query 2014-02-19 10:55 AM

9500 Bug report Closed Normal Wrong list of "result entities ID" after a spatial query 2014-02-19 10:55 AM

9349 Bug report Closed High QGis Zonal Statistics Plugin NoData included in Calculations 2014-06-21 03:07 PM

9349 Bug report Closed High QGis Zonal Statistics Plugin NoData included in Calculations 2014-06-21 03:07 PM

9251 Bug report Closed Normal Georeferencer: Create world file option not resets automatically 2013-12-27 08:21 AM

9251 Bug report Closed Normal Georeferencer: Create world file option not resets automatically 2013-12-27 08:21 AM

9180 Feature request Closed Normal Shortest Path (Road Graph)  plugin cannot handle 2.5D shape files 2014-03-26 11:32 AM

9180 Feature request Closed Normal Shortest Path (Road Graph)  plugin cannot handle 2.5D shape files 2014-03-26 11:32 AM

9174 Bug report Closed High QGIS crashes when calculating Shortest Path (Road Graph) with attached shapefile 2013-12-10 12:52 AM

9174 Bug report Closed High QGIS crashes when calculating Shortest Path (Road Graph) with attached shapefile 2013-12-10 12:52 AM

9157 Bug report Closed Severe/Regression Offline editing tool is very slow when it creates the Spatialite local database 2014-01-12 08:58 AM

9157 Bug report Closed Severe/Regression Offline editing tool is very slow when it creates the Spatialite local database 2014-01-12 08:58 AM

9151 Bug report Closed High zonal stats gives wrong results when features are not overlapped to any raster pixels Marco Hugentobler 2014-06-20 01:32 PM

9151 Bug report Closed High zonal stats gives wrong results when features are not overlapped to any raster pixels Marco Hugentobler 2014-06-20 01:32 PM

8976 Bug report Closed Severe/Regression Offline Editor not retaining key integer values (or if it retains it does not synchronize correctly) 2014-02-08 03:18 AM

8976 Bug report Closed Severe/Regression Offline Editor not retaining key integer values (or if it retains it does not synchronize correctly) 2014-02-08 03:18 AM

8734 Bug report Closed High Bug on dfx2shp plugin 2014-01-26 11:02 AM
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8734 Bug report Closed High Bug on dfx2shp plugin 2014-01-26 11:02 AM

8722 Feature request Closed Normal Remove SPIT 2014-06-20 09:10 AM

8722 Feature request Closed Normal Remove SPIT 2014-06-20 09:10 AM

8696 Feature request Closed Normal Road graph plugin: save also time and length 2014-06-16 07:23 AM

8696 Feature request Closed Normal Road graph plugin: save also time and length 2014-06-16 07:23 AM

8695 Bug report Closed Normal Road graph plugin: no line saved in temp layer 2014-06-16 07:23 AM

8695 Bug report Closed Normal Road graph plugin: no line saved in temp layer 2014-06-16 07:23 AM

8631 Bug report Closed Normal QGIS 2.01 and 2.1 "Add delimited text layer" not working correctly 2013-09-20 01:10 AM

8631 Bug report Closed Normal QGIS 2.01 and 2.1 "Add delimited text layer" not working correctly 2013-09-20 01:10 AM

8469 Bug report Closed Severe/Regression TopologyChecker crash vinayan Parameswaran 2013-08-16 02:36 PM

8469 Bug report Closed Severe/Regression TopologyChecker crash vinayan Parameswaran 2013-08-16 02:36 PM

8433 Bug report Closed Severe/Regression Repeated Crash - Spatial Query tool Jürgen Fischer 2014-02-12 11:56 PM

8433 Bug report Closed Severe/Regression Repeated Crash - Spatial Query tool Jürgen Fischer 2014-02-12 11:56 PM

8237 Bug report Closed Severe/Regression  Georeferencer:Japanese file name problem 2013-07-12 02:55 PM

8237 Bug report Closed Severe/Regression  Georeferencer:Japanese file name problem 2013-07-12 02:55 PM

8194 Bug report Closed Normal Heatmap plugin doesn't work for points along highway Nyall Dawson 2013-08-06 06:17 PM

8194 Bug report Closed Normal Heatmap plugin doesn't work for points along highway Nyall Dawson 2013-08-06 06:17 PM

8193 Bug report Closed Normal Clicking in Rows and Columns fields of Heatmap plugin causes them to keep decrementing by one Nyall Dawson 2013-06-30 06:25 PM

8193 Bug report Closed Normal Clicking in Rows and Columns fields of Heatmap plugin causes them to keep decrementing by one Nyall Dawson 2013-06-30 06:25 PM

8109 Bug report Closed Normal Heatmap module uses DOS 8.3-compatible file extensions for GeoTIFF 2013-06-20 08:08 PM

8109 Bug report Closed Normal Heatmap module uses DOS 8.3-compatible file extensions for GeoTIFF 2013-06-20 08:08 PM

8095 Bug report Closed Severe/Regression Topology checker crashes qgis when clicking on "new project" or when readding a previously checked 

vector

vinayan Parameswaran 2013-07-05 03:16 AM

8095 Bug report Closed Severe/Regression Topology checker crashes qgis when clicking on "new project" or when readding a previously checked 

vector

vinayan Parameswaran 2013-07-05 03:16 AM

8090 Bug report Closed Normal Heatmap plugin resets rows and columns whenever I change the radius 2013-06-26 03:09 PM

8090 Bug report Closed Normal Heatmap plugin resets rows and columns whenever I change the radius 2013-06-26 03:09 PM

8078 Feature request Closed Normal Heatmap plugin should remember prior run's settings 2013-06-26 03:10 PM

8078 Feature request Closed Normal Heatmap plugin should remember prior run's settings 2013-06-26 03:10 PM

7845 Bug report Closed Severe/Regression Topology checker crashes qgis when using the "must not have gaps" rule vinayan Parameswaran 2013-07-21 01:22 AM

7845 Bug report Closed Severe/Regression Topology checker crashes qgis when using the "must not have gaps" rule vinayan Parameswaran 2013-07-21 01:22 AM

7837 Bug report Closed High the attached points shapefile crashes QGIS when used to created an interpolation raster 2013-06-02 07:58 AM

7837 Bug report Closed High the attached points shapefile crashes QGIS when used to created an interpolation raster 2013-06-02 07:58 AM

7624 Bug report Closed Normal QGIS crashes when pressing OK on the heatmap dialog Nyall Dawson 2014-01-26 10:51 AM

7624 Bug report Closed Normal QGIS crashes when pressing OK on the heatmap dialog Nyall Dawson 2014-01-26 10:51 AM

7592 Feature request Closed Normal Add min, max, median and stdev in Zonal statistics 2013-04-14 11:25 PM

7592 Feature request Closed Normal Add min, max, median and stdev in Zonal statistics 2013-04-14 11:25 PM

7584 Bug report Closed Severe/Regression spatial query tool fails to return the right selection 2013-04-14 10:36 AM

7584 Bug report Closed Severe/Regression spatial query tool fails to return the right selection 2013-04-14 10:36 AM

7583 Bug report Closed Severe/Regression spatial query tool fails on master 2013-04-14 09:39 AM

7583 Bug report Closed Severe/Regression spatial query tool fails on master 2013-04-14 09:39 AM

7477 Bug report Closed Severe/Regression Topology checker: crash on Linux as soon a layer is choosen when defining a rule vinayan Parameswaran 2013-04-08 06:42 AM

7477 Bug report Closed Severe/Regression Topology checker: crash on Linux as soon a layer is choosen when defining a rule vinayan Parameswaran 2013-04-08 06:42 AM

7475 Bug report Closed Severe/Regression Topology checker: rule list saved at a project level is (can be) wrong vinayan Parameswaran 2013-04-12 08:24 PM

7475 Bug report Closed Severe/Regression Topology checker: rule list saved at a project level is (can be) wrong vinayan Parameswaran 2013-04-12 08:24 PM

7474 Bug report Closed Severe/Regression Topology checker: QGIS crash on exit, after activating the topology checker panel vinayan Parameswaran 2013-04-13 11:32 AM

7474 Bug report Closed Severe/Regression Topology checker: QGIS crash on exit, after activating the topology checker panel vinayan Parameswaran 2013-04-13 11:32 AM

7473 Bug report Closed Severe/Regression Topology checker: "must not have duplicates" does not work vinayan Parameswaran 2013-04-07 12:17 AM

7473 Bug report Closed Severe/Regression Topology checker: "must not have duplicates" does not work vinayan Parameswaran 2013-04-07 12:17 AM

7444 Bug report Closed Normal Coordinate capture does not copy in the clipboard on Linux 2013-07-17 04:05 AM

7444 Bug report Closed Normal Coordinate capture does not copy in the clipboard on Linux 2013-07-17 04:05 AM

7358 Bug report Closed Normal GPS plugin, input layer for the "upload to GPS" tool is not shown 2014-06-20 12:00 PM

7358 Bug report Closed Normal GPS plugin, input layer for the "upload to GPS" tool is not shown 2014-06-20 12:00 PM

7182 Bug report Closed Normal On linux QGIS freezes 1/2/3... times before allowing download waypoints from a Garmin USB gps unit 2014-06-20 05:50 AM

7182 Bug report Closed Normal On linux QGIS freezes 1/2/3... times before allowing download waypoints from a Garmin USB gps unit 2014-06-20 05:50 AM

7006 Bug report Closed Severe/Regression New core QgsOfflineEditingPlugin crashing app on exit 2013-01-18 01:28 PM

7006 Bug report Closed Severe/Regression New core QgsOfflineEditingPlugin crashing app on exit 2013-01-18 01:28 PM

6904 Bug report Closed Low Move several C++ plugins into core 2017-01-02 01:42 AM

6904 Bug report Closed Low Move several C++ plugins into core 2017-01-02 01:42 AM

6844 Feature request Open Normal Forwarding of finished() to detect external process termination 2017-05-01 12:48 AM

6844 Feature request Open Normal Forwarding of finished() to detect external process termination 2017-05-01 12:48 AM

6810 Bug report Closed Normal QGIS crashes importing delimited text 2013-02-17 01:19 AM

6810 Bug report Closed Normal QGIS crashes importing delimited text 2013-02-17 01:19 AM

6756 Bug report Closed High heatmap plugin is very slow 2013-03-17 01:04 AM

6756 Bug report Closed High heatmap plugin is very slow 2013-03-17 01:04 AM

6692 Bug report Closed Normal Heatmap gives no feedback on progress while running 2013-03-17 01:04 AM

6692 Bug report Closed Normal Heatmap gives no feedback on progress while running 2013-03-17 01:04 AM

6691 Bug report Closed High Heatmap has memory leak 2013-03-17 01:04 AM

6691 Bug report Closed High Heatmap has memory leak 2013-03-17 01:04 AM

6654 Bug report Closed High QgsTINInterpolator.interpolatePoints() called from Python console crashes QGIS 2014-02-12 03:11 AM

6654 Bug report Closed High QgsTINInterpolator.interpolatePoints() called from Python console crashes QGIS 2014-02-12 03:11 AM

6645 Bug report Closed Normal heathmap plugin: the option to load a layer after analyses should be on by default Arunmozhi P 2014-03-28 03:12 AM

6645 Bug report Closed Normal heathmap plugin: the option to load a layer after analyses should be on by default Arunmozhi P 2014-03-28 03:12 AM

6644 Bug report Closed Normal terrain analysis plugin: the option to load a layer after analyses should be on by default Marco Hugentobler 2012-11-07 12:53 AM

6644 Bug report Closed Normal terrain analysis plugin: the option to load a layer after analyses should be on by default Marco Hugentobler 2012-11-07 12:53 AM

6643 Bug report Closed Normal Interpolation plugin: the option to load a layer after analyses should be on by default Marco Hugentobler 2012-11-07 11:45 PM

6643 Bug report Closed Normal Interpolation plugin: the option to load a layer after analyses should be on by default Marco Hugentobler 2012-11-07 11:45 PM

6624 Bug report Closed Normal Zonal statistics returns wrong values Marco Hugentobler 2012-11-10 01:11 PM

6624 Bug report Closed Normal Zonal statistics returns wrong values Marco Hugentobler 2012-11-10 01:11 PM

6524 Bug report Closed High eVis Plug-In, eVis-Database-connection to a MS-Access data base (QGIS 1.8) 2014-02-15 04:25 AM

6524 Bug report Closed High eVis Plug-In, eVis-Database-connection to a MS-Access data base (QGIS 1.8) 2014-02-15 04:25 AM

6521 Bug report Closed Normal QGis Crashes on exit 2012-12-31 11:48 PM

6521 Bug report Closed Normal QGis Crashes on exit 2012-12-31 11:48 PM

6399 Bug report Closed Low "Layer>Create new GPX layer" should be in "new" submenu 2013-06-11 04:42 PM

6399 Bug report Closed Low "Layer>Create new GPX layer" should be in "new" submenu 2013-06-11 04:42 PM

6339 Feature request Closed Normal No way to select CSV file encoding in DelimitedText Plugin 2013-08-09 04:17 AM
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6339 Feature request Closed Normal No way to select CSV file encoding in DelimitedText Plugin 2013-08-09 04:17 AM

6318 Bug report Closed Normal "Download from GPS" stops to work after adding a new device in "GPS Device Editor" 2014-06-20 04:43 AM

6318 Bug report Closed Normal "Download from GPS" stops to work after adding a new device in "GPS Device Editor" 2014-06-20 04:43 AM

6312 Bug report Closed Normal New diagrams: zooming out creates large, out of context pies 2013-03-11 07:11 AM

6312 Bug report Closed Normal New diagrams: zooming out creates large, out of context pies 2013-03-11 07:11 AM

6293 Bug report Closed Severe/Regression evis not able to load MS access database table ersts-amnh-org - 2012-09-03 02:44 AM

6293 Bug report Closed Severe/Regression evis not able to load MS access database table ersts-amnh-org - 2012-09-03 02:44 AM

6146 Bug report Closed Severe/Regression Offline editing tool broken vinayan Parameswaran 2014-02-07 08:24 AM

6146 Bug report Closed Severe/Regression Offline editing tool broken vinayan Parameswaran 2014-02-07 08:24 AM

6105 Bug report Closed Low broken link to old wiki in plugin_template readme 2012-09-04 11:46 PM

6105 Bug report Closed Low broken link to old wiki in plugin_template readme 2012-09-04 11:46 PM

6058 Bug report Closed High GPS Tools freeze QGIS 2014-06-20 04:50 AM

6058 Bug report Closed High GPS Tools freeze QGIS 2014-06-20 04:50 AM

5967 Bug report Closed Normal Wrong Formula in Raster Terrain Analysis' curvature filter Marco Hugentobler 2015-05-25 01:49 AM

5967 Bug report Closed Normal Wrong Formula in Raster Terrain Analysis' curvature filter Marco Hugentobler 2015-05-25 01:49 AM

5760 Bug report Closed Low Heatmap plugin dialog has a wrong layout Tim Sutton 2012-06-07 04:24 PM

5760 Bug report Closed Low Heatmap plugin dialog has a wrong layout Tim Sutton 2012-06-07 04:24 PM

5713 Feature request Closed Normal Make analysis commands callable from Python 2017-01-02 05:04 AM

5713 Feature request Closed Normal Make analysis commands callable from Python 2017-01-02 05:04 AM

5572 Bug report Closed Normal Project properties- Bad allocation 2012-12-30 01:37 PM

5572 Bug report Closed Normal Project properties- Bad allocation 2012-12-30 01:37 PM

5422 Bug report Closed Low eVis database connection broken on Linux? 2012-08-02 04:52 AM

5422 Bug report Closed Low eVis database connection broken on Linux? 2012-08-02 04:52 AM

5328 Bug report Closed Normal SPIT - Geometry type does not match column type 2014-06-22 11:46 AM

5328 Bug report Closed Normal SPIT - Geometry type does not match column type 2014-06-22 11:46 AM

5260 Bug report Closed Normal Georeferencer causes QGIS to crash on exit 2012-05-30 06:13 AM

5260 Bug report Closed Normal Georeferencer causes QGIS to crash on exit 2012-05-30 06:13 AM

5239 Bug report Closed High TIN interpolation causes crash Marco Hugentobler 2014-02-17 12:11 AM

5239 Bug report Closed High TIN interpolation causes crash Marco Hugentobler 2014-02-17 12:11 AM

5107 Bug report Closed High Road graph plugin is broken in 1.7.4 2012-04-15 10:01 AM

5107 Bug report Closed High Road graph plugin is broken in 1.7.4 2012-04-15 10:01 AM

5051 Bug report Closed Low SPIT should add indexes to key and geometry fields 2015-12-08 06:59 AM

5051 Bug report Closed Low SPIT should add indexes to key and geometry fields 2015-12-08 06:59 AM

4972 Bug report Closed Normal  Zonal statistics: wrong IN and OUT files Marco Hugentobler 2012-03-18 01:17 AM

4972 Bug report Closed Normal  Zonal statistics: wrong IN and OUT files Marco Hugentobler 2012-03-18 01:17 AM

4693 Bug report Closed Normal Geomorphology plugin: keeps on forgetting last used folder 2012-01-12 09:00 AM

4693 Bug report Closed Normal Geomorphology plugin: keeps on forgetting last used folder 2012-01-12 09:00 AM

4689 Bug report Closed Normal Track GPS location can't be set to COM15 2011-12-23 05:44 PM

4689 Bug report Closed Normal Track GPS location can't be set to COM15 2011-12-23 05:44 PM

4683 Bug report Closed Normal Coordinate Capture plugin doesn't show its GUI 2011-12-20 02:27 AM

4683 Bug report Closed Normal Coordinate Capture plugin doesn't show its GUI 2011-12-20 02:27 AM

4623 Bug report Closed Normal GPS plugin: "Save as..." does not add file extension 2011-12-16 12:59 AM

4623 Bug report Closed Normal GPS plugin: "Save as..." does not add file extension 2011-12-16 12:59 AM

4603 Bug report Closed Normal "paths to search for additional  C++ plugin libraries" does not work 2011-12-15 08:39 AM

4603 Bug report Closed Normal "paths to search for additional  C++ plugin libraries" does not work 2011-12-15 08:39 AM

4489 Bug report Closed Normal GPS Tracking: segfault on add feature 2012-12-30 10:15 AM

4489 Bug report Closed Normal GPS Tracking: segfault on add feature 2012-12-30 10:15 AM

4392 Bug report Closed Low GRASS-6.4.1: Incompatible library version for module. 2012-04-16 06:59 AM

4392 Bug report Closed Low GRASS-6.4.1: Incompatible library version for module. 2012-04-16 06:59 AM

4391 Bug report Closed Normal GRASS plugin loading fails w/out notice 2011-10-16 05:42 AM

4391 Bug report Closed Normal GRASS plugin loading fails w/out notice 2011-10-16 05:42 AM

4342 Bug report Closed Normal Doxygen output has't QgsGraphAcr class Alexander Bruy 2011-10-02 01:21 AM

4342 Bug report Closed Normal Doxygen output has't QgsGraphAcr class Alexander Bruy 2011-10-02 01:21 AM

4310 Bug report Closed Normal Georeferencer: GCP are not removed from map canvas and the tool does not seem to quit really mmassing - 2012-08-20 05:18 AM

4310 Bug report Closed Normal Georeferencer: GCP are not removed from map canvas and the tool does not seem to quit really mmassing - 2012-08-20 05:18 AM

4308 Bug report Closed Normal Interpolation and Terrain core plugins: do not add custom names? 2011-12-25 08:32 AM

4308 Bug report Closed Normal Interpolation and Terrain core plugins: do not add custom names? 2011-12-25 08:32 AM

4266 Bug report Closed Normal crash on exit if certain C++ plugins are active 2011-09-06 12:22 PM

4266 Bug report Closed Normal crash on exit if certain C++ plugins are active 2011-09-06 12:22 PM

4195 Bug report Closed High Zonal statistics plugin: wrong "sum" and "mean" when the raster is just partially overlapped to a polygon Marco Hugentobler 2011-09-24 09:03 AM

4195 Bug report Closed High Zonal statistics plugin: wrong "sum" and "mean" when the raster is just partially overlapped to a polygon Marco Hugentobler 2011-09-24 09:03 AM

4185 Bug report Closed Low Globe and zonal statistics plugins do not properly unload Pirmin Kalberer 2013-08-28 05:50 AM

4185 Bug report Closed Low Globe and zonal statistics plugins do not properly unload Pirmin Kalberer 2013-08-28 05:50 AM

4178 Bug report Closed Normal Plugin manager does not show c++ plugins in additional plugin path 2012-01-23 10:25 AM

4178 Bug report Closed Normal Plugin manager does not show c++ plugins in additional plugin path 2012-01-23 10:25 AM

4169 Bug report Closed Normal Zonal Statistic Plugin is missing the Toolbar Icon Marco Hugentobler 2012-04-26 01:10 AM

4169 Bug report Closed Normal Zonal Statistic Plugin is missing the Toolbar Icon Marco Hugentobler 2012-04-26 01:10 AM

4114 Bug report Closed Low GDAL Georeferencer Crashes 2012-01-28 04:07 PM

4114 Bug report Closed Low GDAL Georeferencer Crashes 2012-01-28 04:07 PM

4091 Bug report Closed Low Create layer from delimited text (csv) does not work properly for quoted strings 2013-04-15 05:44 PM

4091 Bug report Closed Low Create layer from delimited text (csv) does not work properly for quoted strings 2013-04-15 05:44 PM

4071 Bug report Closed Normal GPS Information (Live GPS tracking) fixes and improvements Steven Mizuno 2011-08-18 11:44 AM

4071 Bug report Closed Normal GPS Information (Live GPS tracking) fixes and improvements Steven Mizuno 2011-08-18 11:44 AM

4050 Bug report Closed Normal GPSD Server WATCH request Michal Klatecki 2013-10-01 07:18 AM

4050 Bug report Closed Normal GPSD Server WATCH request Michal Klatecki 2013-10-01 07:18 AM

3995 Bug report Closed Normal Segfault during use of interpolation plugin 2011-07-22 09:45 AM

3995 Bug report Closed Normal Segfault during use of interpolation plugin 2011-07-22 09:45 AM

3994 Bug report Closed Normal Delimited text plugin does not handle multiple spaces Jürgen Fischer 2011-06-17 02:20 AM

3994 Bug report Closed Normal Delimited text plugin does not handle multiple spaces Jürgen Fischer 2011-06-17 02:20 AM

3967 Bug report Closed Normal Road Graph plugin ignore feature with geometry type WKBMultiLineString Alexander Bruy 2011-06-10 05:44 AM

3967 Bug report Closed Normal Road Graph plugin ignore feature with geometry type WKBMultiLineString Alexander Bruy 2011-06-10 05:44 AM

3849 Feature request Closed Low road-graph plugin not work with Tim Sutton 2011-05-27 12:12 PM

3849 Feature request Closed Low road-graph plugin not work with Tim Sutton 2011-05-27 12:12 PM

3826 Bug report Closed Low Using 100% CPU when connected to GPS 2015-12-19 11:05 AM

3826 Bug report Closed Low Using 100% CPU when connected to GPS 2015-12-19 11:05 AM

3725 Bug report Closed Low Offline Editing plugin issues on both Linux and Windows using trunk Mathias Walker 2011-05-03 02:40 AM
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3725 Bug report Closed Low Offline Editing plugin issues on both Linux and Windows using trunk Mathias Walker 2011-05-03 02:40 AM

3710 Feature request Closed Low SPIT: allow appending data to existing table Tim Sutton 2011-12-09 08:59 AM

3710 Feature request Closed Low SPIT: allow appending data to existing table Tim Sutton 2011-12-09 08:59 AM

3701 Feature request Closed Low eVis: can't create layer from MS Access query Tim Sutton 2011-04-05 09:11 AM

3701 Feature request Closed Low eVis: can't create layer from MS Access query Tim Sutton 2011-04-05 09:11 AM

3699 Bug report Closed Low silent plugin loading failure Tim Sutton 2015-11-20 06:26 AM

3699 Bug report Closed Low silent plugin loading failure Tim Sutton 2015-11-20 06:26 AM

3682 Bug report Closed Low Delimited Text Layer Plugin and empty columns Gary Sherman 2011-03-27 08:39 AM

3682 Bug report Closed Low Delimited Text Layer Plugin and empty columns Gary Sherman 2011-03-27 08:39 AM

3679 Bug report Closed Low eVis not working with point layers Tim Sutton 2011-04-17 12:59 AM

3679 Bug report Closed Low eVis not working with point layers Tim Sutton 2011-04-17 12:59 AM

3631 Feature request Closed Low Delimited Text Enhancement 2013-04-15 05:48 PM

3631 Feature request Closed Low Delimited Text Enhancement 2013-04-15 05:48 PM

3578 Bug report Closed Normal interpolation plugin output without explicit CRS Marco Hugentobler 2014-03-27 06:48 AM

3578 Bug report Closed Normal interpolation plugin output without explicit CRS Marco Hugentobler 2014-03-27 06:48 AM

3570 Feature request Closed Low Delimited text fix for data changes Tim Sutton 2011-03-10 12:24 PM

3570 Feature request Closed Low Delimited text fix for data changes Tim Sutton 2011-03-10 12:24 PM

3546 Bug report Closed Low Offline editing plugin does not sync back Tim Sutton 2014-06-23 09:53 AM

3546 Bug report Closed Low Offline editing plugin does not sync back Tim Sutton 2014-06-23 09:53 AM

3490 Bug report Closed Low Delimited text plugin does not work in trunk Gary Sherman 2011-02-16 01:57 AM

3490 Bug report Closed Low Delimited text plugin does not work in trunk Gary Sherman 2011-02-16 01:57 AM

3416 Feature request Closed Low road-graph plugin Tim Sutton 2011-01-24 03:01 AM

3416 Feature request Closed Low road-graph plugin Tim Sutton 2011-01-24 03:01 AM

3411 Bug report Closed Low Raster based terrain analysis: does not remember the path to the last output raster Marco Hugentobler 2011-02-01 12:43 AM

3411 Bug report Closed Low Raster based terrain analysis: does not remember the path to the last output raster Marco Hugentobler 2011-02-01 12:43 AM

3403 Bug report Closed Low lost focus by click on a object when evis is activate to the layer Tim Sutton 2011-03-06 01:36 PM

3403 Bug report Closed Low lost focus by click on a object when evis is activate to the layer Tim Sutton 2011-03-06 01:36 PM

3382 Feature request Closed Low Include Orfeo Toolbox plugin Tim Sutton 2011-10-27 09:57 AM

3382 Feature request Closed Low Include Orfeo Toolbox plugin Tim Sutton 2011-10-27 09:57 AM

3377 Bug report Closed Low ogr layer converter: converting kml file causes QGIS to crash Tim Sutton 2010-12-30 07:36 AM

3377 Bug report Closed Low ogr layer converter: converting kml file causes QGIS to crash Tim Sutton 2010-12-30 07:36 AM

3338 Feature request Closed Normal zonal statistics Marco Hugentobler 2011-08-11 01:51 PM

3338 Feature request Closed Normal zonal statistics Marco Hugentobler 2011-08-11 01:51 PM

3335 Bug report Closed Low SPIT converts null dates to invalid values Tim Sutton 2011-12-09 09:00 AM

3335 Bug report Closed Low SPIT converts null dates to invalid values Tim Sutton 2011-12-09 09:00 AM

3191 Bug report Closed Low Values in attribute tags of kml export are wrong Tim Sutton 2010-11-06 09:59 AM

3191 Bug report Closed Low Values in attribute tags of kml export are wrong Tim Sutton 2010-11-06 09:59 AM

3188 Bug report Closed Low Bug in delimited text plugin Jürgen Fischer 2010-11-04 03:52 PM

3188 Bug report Closed Low Bug in delimited text plugin Jürgen Fischer 2010-11-04 03:52 PM

3185 Feature request Closed Low Gps Tools: Allow user to add new ports Tim Sutton 2011-12-23 05:43 PM

3185 Feature request Closed Low Gps Tools: Allow user to add new ports Tim Sutton 2011-12-23 05:43 PM

3171 Bug report Closed Low Offline editing plugin: fails with MULTI geometries Marco Hugentobler 2010-11-12 04:16 AM

3171 Bug report Closed Low Offline editing plugin: fails with MULTI geometries Marco Hugentobler 2010-11-12 04:16 AM

3166 Feature request Closed Low Delimited Text Plugin doesn't import files using Mac encoding Tim Sutton 2010-10-29 11:56 AM

3166 Feature request Closed Low Delimited Text Plugin doesn't import files using Mac encoding Tim Sutton 2010-10-29 11:56 AM

3141 Bug report Closed Low Georeferencer transformation type dropdown menu is incorrect Tim Sutton 2010-11-02 12:29 PM

3141 Bug report Closed Low Georeferencer transformation type dropdown menu is incorrect Tim Sutton 2010-11-02 12:29 PM

3140 Bug report Closed Low Download data from GPS doesn't work Tim Sutton 2011-05-31 02:41 AM

3140 Bug report Closed Low Download data from GPS doesn't work Tim Sutton 2011-05-31 02:41 AM

3047 Bug report Closed Low delimited text plugin: import fails if an extra delimiter is at the end Tim Sutton 2011-04-16 05:36 AM

3047 Bug report Closed Low delimited text plugin: import fails if an extra delimiter is at the end Tim Sutton 2011-04-16 05:36 AM

3046 Feature request Closed Low delimited text plugin: add an option to skip first lines Tim Sutton 2010-11-14 08:16 AM

3046 Feature request Closed Low delimited text plugin: add an option to skip first lines Tim Sutton 2010-11-14 08:16 AM

2998 Bug report Closed Low QgisMapServer not rendering grouped layers Marco Hugentobler 2011-01-14 02:55 AM

2998 Bug report Closed Low QgisMapServer not rendering grouped layers Marco Hugentobler 2011-01-14 02:55 AM

2990 Bug report Closed Low qgis_mapserv.fcgi starts to use a lot of memory and not release it after Marco Hugentobler 2010-09-11 02:54 PM

2990 Bug report Closed Low qgis_mapserv.fcgi starts to use a lot of memory and not release it after Marco Hugentobler 2010-09-11 02:54 PM

2988 Bug report Closed Low segfaults on making interpolation Marco Hugentobler 2010-10-23 01:32 AM

2988 Bug report Closed Low segfaults on making interpolation Marco Hugentobler 2010-10-23 01:32 AM

2948 Feature request Closed Low PDF map for georeferencer Marco Hugentobler 2010-09-05 07:13 AM

2948 Feature request Closed Low PDF map for georeferencer Marco Hugentobler 2010-09-05 07:13 AM

2891 Bug report Closed Low WFS exceptions not handled by plugin Tim Sutton 2010-07-24 12:25 AM

2891 Bug report Closed Low WFS exceptions not handled by plugin Tim Sutton 2010-07-24 12:25 AM

2881 Feature request Closed Low Georeference's plugin  have use  translator text to COMPRESS argument in gdalwarp mmassing - 2010-07-25 11:58 PM

2881 Feature request Closed Low Georeference's plugin  have use  translator text to COMPRESS argument in gdalwarp mmassing - 2010-07-25 11:58 PM

2814 Bug report Closed Low in georeferencer, filename confusion with multiple georeferencing Tim Sutton 2010-06-17 12:34 AM

2814 Bug report Closed Low in georeferencer, filename confusion with multiple georeferencing Tim Sutton 2010-06-17 12:34 AM

2802 Bug report Closed Low georeferencer plug-in produce wrong results Tim Sutton 2010-06-12 09:08 AM

2802 Bug report Closed Low georeferencer plug-in produce wrong results Tim Sutton 2010-06-12 09:08 AM

2759 Bug report Closed Low (linux) clicking "select georaster" icon in the plugin toolbar crashes qgis Tim Sutton 2010-05-30 11:57 AM

2759 Bug report Closed Low (linux) clicking "select georaster" icon in the plugin toolbar crashes qgis Tim Sutton 2010-05-30 11:57 AM

2747 Feature request Closed Low possibility to suppress labels for small features Martin Dobias 2010-05-29 03:33 AM

2747 Feature request Closed Low possibility to suppress labels for small features Martin Dobias 2010-05-29 03:33 AM

2739 Feature request Closed Low patch to scale label buffers and offsets for printing Martin Dobias 2010-05-29 04:03 PM

2739 Feature request Closed Low patch to scale label buffers and offsets for printing Martin Dobias 2010-05-29 04:03 PM

2736 Bug report Closed Low fTools: split vector does not work Tim Sutton 2010-05-21 12:49 AM

2736 Bug report Closed Low fTools: split vector does not work Tim Sutton 2010-05-21 12:49 AM

2698 Bug report Closed Low georeferencer plugin generate pdf report with wrong dx margin Marco Hugentobler 2010-06-12 02:20 AM

2698 Bug report Closed Low georeferencer plugin generate pdf report with wrong dx margin Marco Hugentobler 2010-06-12 02:20 AM

2676 Feature request Closed Low SPIT plugin - serial datatype instead of integer on primary key column Tim Sutton 2010-04-24 01:28 AM

2676 Feature request Closed Low SPIT plugin - serial datatype instead of integer on primary key column Tim Sutton 2010-04-24 01:28 AM

2673 Feature request Closed Low Enhancements for georeferencer mmassing - 2010-05-21 02:37 AM

2673 Feature request Closed Low Enhancements for georeferencer mmassing - 2010-05-21 02:37 AM

2634 Feature request Closed Low Spatial Query Plugin source for evaluation Tim Sutton 2011-03-15 03:57 AM

2634 Feature request Closed Low Spatial Query Plugin source for evaluation Tim Sutton 2011-03-15 03:57 AM

2633 Feature request Closed Low option to snap gcp coordinates to background layers mmassing - 2010-04-11 05:46 AM
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2633 Feature request Closed Low option to snap gcp coordinates to background layers mmassing - 2010-04-11 05:46 AM

2622 Feature request Closed Low Patch to visualize residuals mmassing - 2010-04-03 09:47 AM

2622 Feature request Closed Low Patch to visualize residuals mmassing - 2010-04-03 09:47 AM

2621 Bug report Closed Low eVis Event Browser missing records ersts - 2010-05-25 12:51 PM

2621 Bug report Closed Low eVis Event Browser missing records ersts - 2010-05-25 12:51 PM

2583 Feature request Closed Low Use distance tolerance in point displacement plugin Marco Hugentobler 2010-03-23 08:37 AM

2583 Feature request Closed Low Use distance tolerance in point displacement plugin Marco Hugentobler 2010-03-23 08:37 AM

2551 Bug report Closed Low SPIT crashes if path to shapefile contains cyrillic 2011-02-13 07:14 PM

2551 Bug report Closed Low SPIT crashes if path to shapefile contains cyrillic 2011-02-13 07:14 PM

2524 Bug report Closed Low actions: problem when a column is named as the first part of another column name Tim Sutton 2010-03-08 01:27 AM

2524 Bug report Closed Low actions: problem when a column is named as the first part of another column name Tim Sutton 2010-03-08 01:27 AM

2482 Bug report Closed High Interpolation plugin causes seg fault Marco Hugentobler 2012-05-30 05:24 AM

2482 Bug report Closed High Interpolation plugin causes seg fault Marco Hugentobler 2012-05-30 05:24 AM

2480 Feature request Closed Low Quoted filenames in Georeferencer scripts mmassing - 2010-04-03 12:07 PM

2480 Feature request Closed Low Quoted filenames in Georeferencer scripts mmassing - 2010-04-03 12:07 PM

2465 Bug report Closed Normal Georeferencer: does not correctly handle files with existing georeferencing information mmassing - 2012-09-10 04:42 AM

2465 Bug report Closed Normal Georeferencer: does not correctly handle files with existing georeferencing information mmassing - 2012-09-10 04:42 AM

2464 Bug report Closed Low Georeferencer: Selection of custom projection as target SRS is not followed mmassing - 2010-02-23 03:22 AM

2464 Bug report Closed Low Georeferencer: Selection of custom projection as target SRS is not followed mmassing - 2010-02-23 03:22 AM

2453 Bug report Closed Low New georeferencer can't read old GCP files mmassing - 2010-06-12 03:00 AM

2453 Bug report Closed Low New georeferencer can't read old GCP files mmassing - 2010-06-12 03:00 AM

2449 Bug report Closed Low georeferencer: gcp list ordering is lexicographic, and does not auto-refresh mmassing - 2010-07-28 03:14 PM

2449 Bug report Closed Low georeferencer: gcp list ordering is lexicographic, and does not auto-refresh mmassing - 2010-07-28 03:14 PM

2443 Bug report Closed Low georeferencer switches 'link georeferencer to QGIS' and 'link  QGIS to georeferencer' labels mmassing - 2010-02-15 03:02 AM

2443 Bug report Closed Low georeferencer switches 'link georeferencer to QGIS' and 'link  QGIS to georeferencer' labels mmassing - 2010-02-15 03:02 AM

2418 Bug report Closed Low OGR layer converter errors 2011-03-04 09:48 AM

2418 Bug report Closed Low OGR layer converter errors 2011-03-04 09:48 AM

2401 Bug report Closed Low georeferencer crash on Helmert transform Tim Sutton 2010-02-03 03:59 AM

2401 Bug report Closed Low georeferencer crash on Helmert transform Tim Sutton 2010-02-03 03:59 AM

2384 Bug report Closed Low Oracle Spatial GeoRaster plugin can't create new connections Gary Sherman 2010-01-22 08:32 AM

2384 Bug report Closed Low Oracle Spatial GeoRaster plugin can't create new connections Gary Sherman 2010-01-22 08:32 AM

2360 Bug report Closed Low 'Live GPS tracking' not functioning, OSGeo4W trunk (Windows XP) Tim Sutton 2010-01-13 05:14 PM

2360 Bug report Closed Low 'Live GPS tracking' not functioning, OSGeo4W trunk (Windows XP) Tim Sutton 2010-01-13 05:14 PM

2306 Feature request Closed Low Diagram overlay: GUI unclear Marco Hugentobler 2013-03-16 01:14 PM

2306 Feature request Closed Low Diagram overlay: GUI unclear Marco Hugentobler 2013-03-16 01:14 PM

2277 Feature request Closed Low fix for CopyrightLabel position Tim Sutton 2009-12-13 02:06 PM

2277 Feature request Closed Low fix for CopyrightLabel position Tim Sutton 2009-12-13 02:06 PM

2228 Bug report Closed Low GPS Tools: "GPX Conversions" doesn't work Tim Sutton 2011-12-11 08:21 AM

2228 Bug report Closed Low GPS Tools: "GPX Conversions" doesn't work Tim Sutton 2011-12-11 08:21 AM

2227 Bug report Closed Low GPS Tools: "Import  other file" doesn't work gjm - 2011-04-21 12:47 AM

2227 Bug report Closed Low GPS Tools: "Import  other file" doesn't work gjm - 2011-04-21 12:47 AM

2215 Bug report Closed Low eVis plugin not displaying attributes in viewer ersts - 2009-12-21 07:23 AM

2215 Bug report Closed Low eVis plugin not displaying attributes in viewer ersts - 2009-12-21 07:23 AM

2214 Bug report Closed Low georeferencer windows passes behind qgis main window when choosing points from canvas Tim Sutton 2010-02-22 03:10 AM

2214 Bug report Closed Low georeferencer windows passes behind qgis main window when choosing points from canvas Tim Sutton 2010-02-22 03:10 AM

2212 Bug report Closed Low Labels don't fit into button nobody - 2009-12-08 12:47 PM

2212 Bug report Closed Low Labels don't fit into button nobody - 2009-12-08 12:47 PM

2211 Bug report Closed Low Georeferencing warp dialog non-functional Tim Sutton 2009-12-08 03:33 PM

2211 Bug report Closed Low Georeferencing warp dialog non-functional Tim Sutton 2009-12-08 03:33 PM

2203 Bug report Closed Low GPS Tools: spaces in Output File path 2010-06-12 10:59 AM

2203 Bug report Closed Low GPS Tools: spaces in Output File path 2010-06-12 10:59 AM

2196 Bug report Closed Low terrain analysis plugin: slope does not work Marco Hugentobler 2010-01-02 10:41 AM

2196 Bug report Closed Low terrain analysis plugin: slope does not work Marco Hugentobler 2010-01-02 10:41 AM

2195 Feature request Closed Low DXF2SHP converter plugin improvement 2010-02-10 08:58 AM

2195 Feature request Closed Low DXF2SHP converter plugin improvement 2010-02-10 08:58 AM

2176 Bug report Closed Low OGR converter: CSV export is broken 2011-03-04 09:52 AM

2176 Bug report Closed Low OGR converter: CSV export is broken 2011-03-04 09:52 AM

2165 Bug report Closed Low Coordinate Capture position display has 3 decimal places for long/lat on QGIS start up Tim Sutton 2009-11-29 10:00 AM

2165 Bug report Closed Low Coordinate Capture position display has 3 decimal places for long/lat on QGIS start up Tim Sutton 2009-11-29 10:00 AM

2146 Bug report Closed Low PostGres connection exposes username and password Tim Sutton 2010-03-07 10:18 AM

2146 Bug report Closed Low PostGres connection exposes username and password Tim Sutton 2010-03-07 10:18 AM

2142 Bug report Closed Low slope, aspect, idw, tin rasters saved without the .tif file extension Marco Hugentobler 2014-06-23 01:40 AM

2142 Bug report Closed Low slope, aspect, idw, tin rasters saved without the .tif file extension Marco Hugentobler 2014-06-23 01:40 AM

2129 Feature request Closed Low GPX as 4326 (also KML) Tim Sutton 2010-05-05 06:22 AM

2129 Feature request Closed Low GPX as 4326 (also KML) Tim Sutton 2010-05-05 06:22 AM

2118 Feature request Closed Low OGR converter: add filters for file names Tim Sutton 2011-03-04 09:50 AM

2118 Feature request Closed Low OGR converter: add filters for file names Tim Sutton 2011-03-04 09:50 AM

2005 Bug report Closed Low interpolation plugin crashes QGIS Marco Hugentobler 2009-11-06 08:15 AM

2005 Bug report Closed Low interpolation plugin crashes QGIS Marco Hugentobler 2009-11-06 08:15 AM

1995 Bug report Closed Low Impossible too enter SRID > 1000000 in Spit Tim Sutton 2009-10-10 10:44 AM

1995 Bug report Closed Low Impossible too enter SRID > 1000000 in Spit Tim Sutton 2009-10-10 10:44 AM

1991 Bug report Closed Low Interpolation plugin does not set file extension to tif Marco Hugentobler 2009-11-24 01:06 PM

1991 Bug report Closed Low Interpolation plugin does not set file extension to tif Marco Hugentobler 2009-11-24 01:06 PM

1990 Bug report Closed Low Set to current extent wrong for interpolation plugin Marco Hugentobler 2009-11-04 12:55 PM

1990 Bug report Closed Low Set to current extent wrong for interpolation plugin Marco Hugentobler 2009-11-04 12:55 PM

1930 Bug report Closed Low OSM layer has missing road Tim Sutton 2009-12-19 08:24 AM

1930 Bug report Closed Low OSM layer has missing road Tim Sutton 2009-12-19 08:24 AM

1823 Feature request Closed Low Highlight point in Zoom to Point Tim Sutton 2014-06-21 02:12 PM

1823 Feature request Closed Low Highlight point in Zoom to Point Tim Sutton 2014-06-21 02:12 PM

1782 Bug report Closed Low unable to load a .png file nobody - 2009-08-04 06:41 AM

1782 Bug report Closed Low unable to load a .png file nobody - 2009-08-04 06:41 AM

1729 Feature request Closed Low MapInfo: OGR layer converter doesn't work 2011-03-04 09:51 AM

1729 Feature request Closed Low MapInfo: OGR layer converter doesn't work 2011-03-04 09:51 AM

1715 Bug report Closed Low QGIS on Mac and Text Delimited Layer plug in fails nobody - 2009-07-18 09:34 AM

1715 Bug report Closed Low QGIS on Mac and Text Delimited Layer plug in fails nobody - 2009-07-18 09:34 AM

1714 Feature request Closed Low "Use selection" patch for fTools cfarmer - 2009-05-27 05:46 AM
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1714 Feature request Closed Low "Use selection" patch for fTools cfarmer - 2009-05-27 05:46 AM

1691 Bug report Closed Low fTools->Geometry Tools->Export/Add geometry columns doesn't work with PostGIS Layers cfarmer - 2009-07-16 01:02 AM

1691 Bug report Closed Low fTools->Geometry Tools->Export/Add geometry columns doesn't work with PostGIS Layers cfarmer - 2009-07-16 01:02 AM

1690 Bug report Closed Low Tools->Research Tools->Select by location crashes with PostGIS-Layer cfarmer - 2009-05-13 06:02 AM

1690 Bug report Closed Low Tools->Research Tools->Select by location crashes with PostGIS-Layer cfarmer - 2009-05-13 06:02 AM

1655 Bug report Closed Low Lacking translation causes malfunction nobody - 2009-04-26 03:38 PM

1655 Bug report Closed Low Lacking translation causes malfunction nobody - 2009-04-26 03:38 PM

1600 Bug report Closed Low georeferencer fails with Critical error nobody - 2009-07-12 09:50 AM

1600 Bug report Closed Low georeferencer fails with Critical error nobody - 2009-07-12 09:50 AM

1593 Feature request Closed Low Oracle GeoRaster Plugin ilucena - 2009-04-28 10:21 AM

1593 Feature request Closed Low Oracle GeoRaster Plugin ilucena - 2009-04-28 10:21 AM

1592 Bug report Closed Low Coordinate capture plugin - projection selector nobody - 2009-05-06 12:26 PM

1592 Bug report Closed Low Coordinate capture plugin - projection selector nobody - 2009-05-06 12:26 PM

1560 Bug report Closed Low virus nobody - 2009-02-25 04:50 AM

1560 Bug report Closed Low virus nobody - 2009-02-25 04:50 AM

1552 Bug report Closed Low plug-in installer does not work behind proxy nobody - 2009-04-21 11:43 PM

1552 Bug report Closed Low plug-in installer does not work behind proxy nobody - 2009-04-21 11:43 PM

1531 Bug report Closed Low Georeferencer GDAL crashes QGIS Maxim Dubinin 2009-07-19 01:28 AM

1531 Bug report Closed Low Georeferencer GDAL crashes QGIS Maxim Dubinin 2009-07-19 01:28 AM

1524 Bug report Closed Low fTools resultant shape doesn't overwrite existing shape cfarmer - 2009-08-22 01:01 AM

1524 Bug report Closed Low fTools resultant shape doesn't overwrite existing shape cfarmer - 2009-08-22 01:01 AM

1512 Feature request Closed Low plugins/analyses menu appears twice Borys Jurgiel 2009-08-22 01:01 AM

1512 Feature request Closed Low plugins/analyses menu appears twice Borys Jurgiel 2009-08-22 01:01 AM

1508 Bug report Closed Low fTools Geoprocessing Dissolve Crashes QGIS cfarmer - 2009-08-22 01:01 AM

1508 Bug report Closed Low fTools Geoprocessing Dissolve Crashes QGIS cfarmer - 2009-08-22 01:01 AM

1478 Feature request Closed Low Coordinate Capture plugin - fixes and enhancements Tim Sutton 2009-08-22 01:01 AM

1478 Feature request Closed Low Coordinate Capture plugin - fixes and enhancements Tim Sutton 2009-08-22 01:01 AM

1465 Feature request Closed Low plugin installer fails nobody - 2009-08-22 12:57 AM

1465 Feature request Closed Low plugin installer fails nobody - 2009-08-22 12:57 AM

1437 Feature request Closed Low improve dxf plugin Tim Sutton 2010-06-11 10:12 PM

1437 Feature request Closed Low improve dxf plugin Tim Sutton 2010-06-11 10:12 PM

1432 Bug report Closed Low Delimited text import: precision loss (latlong) nobody - 2009-08-22 01:02 AM

1432 Bug report Closed Low Delimited text import: precision loss (latlong) nobody - 2009-08-22 01:02 AM

1405 Bug report Closed Low Python Plugin Installer not UTF-8 aware Borys Jurgiel 2009-08-22 12:57 AM

1405 Bug report Closed Low Python Plugin Installer not UTF-8 aware Borys Jurgiel 2009-08-22 12:57 AM

1404 Feature request Closed Low improvement for georeferencer plugin nobody - 2009-07-15 08:55 AM

1404 Feature request Closed Low improvement for georeferencer plugin nobody - 2009-07-15 08:55 AM

1378 Bug report Closed Low python plugin not loaded nobody - 2009-08-22 12:57 AM

1378 Bug report Closed Low python plugin not loaded nobody - 2009-08-22 12:57 AM

1343 Bug report Closed Low dxf2shp plugin does not distinguish between polygon and polyline correctly 2011-12-09 09:04 AM

1343 Bug report Closed Low dxf2shp plugin does not distinguish between polygon and polyline correctly 2011-12-09 09:04 AM

1342 Bug report Closed Low dxf2shp plugin does not distinguish between polygon and polyline correctly nobody - 2009-08-22 12:57 AM

1342 Bug report Closed Low dxf2shp plugin does not distinguish between polygon and polyline correctly nobody - 2009-08-22 12:57 AM

1330 Bug report Closed Low SPIT fails to load shapefile when no fields detected nobody - 2009-07-19 01:55 AM

1330 Bug report Closed Low SPIT fails to load shapefile when no fields detected nobody - 2009-07-19 01:55 AM

1308 Feature request Closed Low dxf plugin crashes QGIS nobody - 2011-03-07 08:46 AM

1308 Feature request Closed Low dxf plugin crashes QGIS nobody - 2011-03-07 08:46 AM

1269 Bug report Closed Low DXF converter creates a corrupted Shapefile nobody - 2009-08-22 01:02 AM

1269 Bug report Closed Low DXF converter creates a corrupted Shapefile nobody - 2009-08-22 01:02 AM

1260 Bug report Closed Low graticule creator: fields "Row", "Col", "RowCol" all NULL nobody - 2009-08-22 01:01 AM

1260 Bug report Closed Low graticule creator: fields "Row", "Col", "RowCol" all NULL nobody - 2009-08-22 01:01 AM

1257 Bug report Closed Low graticule creator: don't assume 0 interval avoid avoid a freeze nobody - 2009-08-22 12:57 AM

1257 Bug report Closed Low graticule creator: don't assume 0 interval avoid avoid a freeze nobody - 2009-08-22 12:57 AM

1255 Bug report Closed Low georeferencer: refuses to delete some GCPs or deletes wrong ones, crashes at times Magnus Homann 2009-08-22 12:57 AM

1255 Bug report Closed Low georeferencer: refuses to delete some GCPs or deletes wrong ones, crashes at times Magnus Homann 2009-08-22 12:57 AM

1249 Feature request Closed Low Submission of OGR Layer Converter plugin Marco Hugentobler 2009-08-22 01:01 AM

1249 Feature request Closed Low Submission of OGR Layer Converter plugin Marco Hugentobler 2009-08-22 01:01 AM

1246 Bug report Closed Low WFS plug-in should handle SRS from servers nobody - 2009-08-22 12:57 AM

1246 Bug report Closed Low WFS plug-in should handle SRS from servers nobody - 2009-08-22 12:57 AM

1243 Bug report Closed Low plugin_builder.py generates README with broken URL to API reference nobody - 2009-08-22 12:57 AM

1243 Bug report Closed Low plugin_builder.py generates README with broken URL to API reference nobody - 2009-08-22 12:57 AM

1236 Bug report Closed Low Invalid use of stream operator dxf2shp converter nobody - 2008-08-23 06:55 AM

1236 Bug report Closed Low Invalid use of stream operator dxf2shp converter nobody - 2008-08-23 06:55 AM

1235 Bug report Closed Low Invalid multiline string literal in dxf2shp converter nobody - 2008-08-21 03:52 PM

1235 Bug report Closed Low Invalid multiline string literal in dxf2shp converter nobody - 2008-08-21 03:52 PM

1234 Bug report Closed Low Suspicious retrival of active layer in dxf2shp converter nobody - 2008-08-21 03:51 PM

1234 Bug report Closed Low Suspicious retrival of active layer in dxf2shp converter nobody - 2008-08-21 03:51 PM

1233 Bug report Closed Low EPSG code assigned to temporary object nobody - 2009-08-22 12:57 AM

1233 Bug report Closed Low EPSG code assigned to temporary object nobody - 2009-08-22 12:57 AM

1212 Bug report Closed Low "spatial operation on vector layer" dialog shows operatio instead of operation (label field to small) nobody - 2009-08-22 01:01 AM

1212 Bug report Closed Low "spatial operation on vector layer" dialog shows operatio instead of operation (label field to small) nobody - 2009-08-22 01:01 AM

1209 Feature request Closed Low GPS plugin - use stored path for all file browser dialogs; also save/use file type 2012-01-12 09:01 AM

1209 Feature request Closed Low GPS plugin - use stored path for all file browser dialogs; also save/use file type 2012-01-12 09:01 AM

1156 Feature request Closed Low Purge negative id on selection when commit nobody - 2009-08-22 12:57 AM

1156 Feature request Closed Low Purge negative id on selection when commit nobody - 2009-08-22 12:57 AM

1116 Feature request Closed Low Symlinks in plugin directory nobody - 2010-06-11 10:03 PM

1116 Feature request Closed Low Symlinks in plugin directory nobody - 2010-06-11 10:03 PM

1091 Bug report Closed Low Plugin Manager - clicking checkboxes doesn't work (Windows v. 0.10.0) nobody - 2008-05-17 10:57 AM

1091 Bug report Closed Low Plugin Manager - clicking checkboxes doesn't work (Windows v. 0.10.0) nobody - 2008-05-17 10:57 AM

1070 Bug report Closed Low Plugin Manager can't find plugin directory nobody - 2009-08-22 12:57 AM

1070 Bug report Closed Low Plugin Manager can't find plugin directory nobody - 2009-08-22 12:57 AM

1065 Feature request Closed Low Symbol Composer plugin nobody - 2009-11-30 01:36 AM

1065 Feature request Closed Low Symbol Composer plugin nobody - 2009-11-30 01:36 AM

1022 Feature request Closed Low delimited text layer plugin: robustness Magnus Homann 2010-10-30 09:37 AM

1022 Feature request Closed Low delimited text layer plugin: robustness Magnus Homann 2010-10-30 09:37 AM

990 Bug report Closed Low Geoprocessing/Buffer features plug-in - various defects: i18n, PG connection leak, fails to load buffer layer Gary Sherman 2009-08-22 12:57 AM
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990 Bug report Closed Low Geoprocessing/Buffer features plug-in - various defects: i18n, PG connection leak, fails to load buffer layer Gary Sherman 2009-08-22 12:57 AM

973 Bug report Closed Low Georeferencer - right-clicking in "delete point" mode behave incorrectly and crashes nobody - 2009-08-22 12:57 AM

973 Bug report Closed Low Georeferencer - right-clicking in "delete point" mode behave incorrectly and crashes nobody - 2009-08-22 12:57 AM

928 Bug report Closed Low Plugin Manager: let select/de-select plugins also by clicking within the checkbox nobody - 2009-08-22 12:54 AM

928 Bug report Closed Low Plugin Manager: let select/de-select plugins also by clicking within the checkbox nobody - 2009-08-22 12:54 AM

920 Bug report Closed Low Plugin Manager activation toggle not clickable nobody - 2009-08-22 12:54 AM

920 Bug report Closed Low Plugin Manager activation toggle not clickable nobody - 2009-08-22 12:54 AM

909 Bug report Closed Low Plugin manager usability problems Fernando Pacheco - 2009-08-22 12:54 AM

909 Bug report Closed Low Plugin manager usability problems Fernando Pacheco - 2009-08-22 12:54 AM

904 Bug report Closed Low No decorations Marco Hugentobler 2008-01-17 01:16 AM

904 Bug report Closed Low No decorations Marco Hugentobler 2008-01-17 01:16 AM

896 Bug report Closed Low Quickprint Plugin scaling issues Tim Sutton 2011-03-02 09:29 PM

896 Bug report Closed Low Quickprint Plugin scaling issues Tim Sutton 2011-03-02 09:29 PM

895 Feature request Closed Low Upgrading plugins in python plugin installer nobody - 2009-08-22 12:57 AM

895 Feature request Closed Low Upgrading plugins in python plugin installer nobody - 2009-08-22 12:57 AM

894 Feature request Closed Low Custom repositories for python plugin installer nobody - 2009-08-22 12:54 AM

894 Feature request Closed Low Custom repositories for python plugin installer nobody - 2009-08-22 12:54 AM

892 Feature request Closed Low update qgspluginmanager nobody - 2009-08-22 12:54 AM

892 Feature request Closed Low update qgspluginmanager nobody - 2009-08-22 12:54 AM

872 Bug report Closed Low Error in C++ plugin templates files Magnus Homann 2009-08-22 12:54 AM

872 Bug report Closed Low Error in C++ plugin templates files Magnus Homann 2009-08-22 12:54 AM

868 Bug report Closed Low Helmert transform in Georeferencer plugin creates incorrect world file nobody - 2009-08-22 12:54 AM

868 Bug report Closed Low Helmert transform in Georeferencer plugin creates incorrect world file nobody - 2009-08-22 12:54 AM

856 Feature request Closed Low WFS plugin fails to connect to Geoserver Marco Hugentobler 2009-08-22 12:54 AM

856 Feature request Closed Low WFS plugin fails to connect to Geoserver Marco Hugentobler 2009-08-22 12:54 AM

847 Bug report Closed Low delimited text import plugin skips the first input point Gavin Macaulay - 2009-08-22 12:54 AM

847 Bug report Closed Low delimited text import plugin skips the first input point Gavin Macaulay - 2009-08-22 12:54 AM

804 Bug report Closed Low GPS Import file selection is not intuitive Magnus Homann 2009-08-22 12:54 AM

804 Bug report Closed Low GPS Import file selection is not intuitive Magnus Homann 2009-08-22 12:54 AM

749 Feature request Closed Low Graticule plugin enhancements Tim Sutton 2009-08-22 01:02 AM

749 Feature request Closed Low Graticule plugin enhancements Tim Sutton 2009-08-22 01:02 AM

747 Bug report Closed Low importing 3D geom into PostGIS via SPIT plugin 2011-12-09 09:01 AM

747 Bug report Closed Low importing 3D geom into PostGIS via SPIT plugin 2011-12-09 09:01 AM

696 Bug report Closed Low .GPX from IGO gps not loaded completely Magnus Homann 2009-08-22 12:54 AM

696 Bug report Closed Low .GPX from IGO gps not loaded completely Magnus Homann 2009-08-22 12:54 AM

691 Bug report Closed Low Crash upon loading text delimited file nobody - 2009-08-22 12:52 AM

691 Bug report Closed Low Crash upon loading text delimited file nobody - 2009-08-22 12:52 AM

659 Bug report Closed Low OS X world file incorrectly generated by Georeferencer plugin Magnus Homann 2009-08-22 12:54 AM

659 Bug report Closed Low OS X world file incorrectly generated by Georeferencer plugin Magnus Homann 2009-08-22 12:54 AM

654 Bug report Closed Low Graticule creator crash (WINDOWS) Tim Sutton 2009-08-22 12:51 AM

654 Bug report Closed Low Graticule creator crash (WINDOWS) Tim Sutton 2009-08-22 12:51 AM

644 Feature request Closed Low Grid plugin: nobody - 2009-08-22 12:52 AM

644 Feature request Closed Low Grid plugin: nobody - 2009-08-22 12:52 AM

624 Bug report Closed Low on linux qgis-0.8.0 points which are entered for georerencer are a lot shifted after opération nobody - 2009-08-22 12:51 AM

624 Bug report Closed Low on linux qgis-0.8.0 points which are entered for georerencer are a lot shifted after opération nobody - 2009-08-22 12:51 AM

622 Bug report Closed Low unable to delete fist point enter for georeferencer map on linux qgis-0.8.0 "titan" nobody - 2009-08-22 12:46 AM

622 Bug report Closed Low unable to delete fist point enter for georeferencer map on linux qgis-0.8.0 "titan" nobody - 2009-08-22 12:46 AM

621 Bug report Closed Low on last windows version georeferencer returns error(14) :unable to open database SRS.db Magnus Homann 2009-08-22 12:51 AM

621 Bug report Closed Low on last windows version georeferencer returns error(14) :unable to open database SRS.db Magnus Homann 2009-08-22 12:51 AM

620 Bug report Closed Low unable to delete the first point enter in georeferencer on linux qgis-0.8.0 (Titan) Magnus Homann 2009-08-22 12:51 AM

620 Bug report Closed Low unable to delete the first point enter in georeferencer on linux qgis-0.8.0 (Titan) Magnus Homann 2009-08-22 12:51 AM

619 Bug report Closed Low error(14) return when I try to load WMS layer with EPSG=27582 Magnus Homann 2009-08-22 12:51 AM

619 Bug report Closed Low error(14) return when I try to load WMS layer with EPSG=27582 Magnus Homann 2009-08-22 12:51 AM

601 Bug report Closed Low Georeferencer plugin incorrectly handles PNG files Magnus Homann 2009-08-22 12:51 AM

601 Bug report Closed Low Georeferencer plugin incorrectly handles PNG files Magnus Homann 2009-08-22 12:51 AM

576 Bug report Closed Low Measuring tool -- the measured distances are changing chaotically and the numbers are a way off Magnus Homann 2009-08-22 12:45 AM

576 Bug report Closed Low Measuring tool -- the measured distances are changing chaotically and the numbers are a way off Magnus Homann 2009-08-22 12:45 AM

568 Bug report Closed Low tiff file no longer viewable after georeferencing nobody - 2009-08-22 12:51 AM

568 Bug report Closed Low tiff file no longer viewable after georeferencing nobody - 2009-08-22 12:51 AM

564 Bug report Closed Low gpx provider saves coordinates to low precision Magnus Homann 2009-08-22 12:51 AM

564 Bug report Closed Low gpx provider saves coordinates to low precision Magnus Homann 2009-08-22 12:51 AM

560 Bug report Closed Low georeferencing tool Gary Sherman 2009-08-22 12:51 AM

560 Bug report Closed Low georeferencing tool Gary Sherman 2009-08-22 12:51 AM

538 Bug report Closed Low delimited text plug-in lets QGIS crash on windows nobody - 2009-08-22 12:51 AM

538 Bug report Closed Low delimited text plug-in lets QGIS crash on windows nobody - 2009-08-22 12:51 AM

529 Bug report Closed Low Doubled items in plugin manager nobody - 2009-08-22 12:51 AM

529 Bug report Closed Low Doubled items in plugin manager nobody - 2009-08-22 12:51 AM

506 Bug report Closed Low qgis 0.8 bug: postgis views Gavin Macaulay - 2009-08-22 12:52 AM

506 Bug report Closed Low qgis 0.8 bug: postgis views Gavin Macaulay - 2009-08-22 12:52 AM

483 Feature request Closed Low Provide regular expression separators for the delimited text plugin Gavin Macaulay - 2009-08-22 12:52 AM

483 Feature request Closed Low Provide regular expression separators for the delimited text plugin Gavin Macaulay - 2009-08-22 12:52 AM

482 Bug report Closed Low Incorrect point placement nobody - 2007-01-01 08:06 PM

482 Bug report Closed Low Incorrect point placement nobody - 2007-01-01 08:06 PM

479 Bug report Closed Low Georeferencer doesn't use decimals nobody - 2007-01-01 12:32 PM

479 Bug report Closed Low Georeferencer doesn't use decimals nobody - 2007-01-01 12:32 PM

478 Bug report Closed Low Georeferencer doesn't use decimals nobody - 2007-01-01 12:51 PM

478 Bug report Closed Low Georeferencer doesn't use decimals nobody - 2007-01-01 12:51 PM

469 Bug report Closed Low WinQGIS: Cannot load gpx files Tim Sutton 2009-08-22 12:46 AM

469 Bug report Closed Low WinQGIS: Cannot load gpx files Tim Sutton 2009-08-22 12:46 AM

466 Bug report Closed Low WinQGIS: problem with Lizardtech WMS server Tim Sutton 2009-08-22 12:46 AM

466 Bug report Closed Low WinQGIS: problem with Lizardtech WMS server Tim Sutton 2009-08-22 12:46 AM

465 Bug report Closed Low WMS server: Nasa connection does not work Tim Sutton 2009-08-22 12:46 AM

465 Bug report Closed Low WMS server: Nasa connection does not work Tim Sutton 2009-08-22 12:46 AM

464 Bug report Closed Low WinQGIS: the georeferecer module does not work Tim Sutton 2009-08-22 12:46 AM

464 Bug report Closed Low WinQGIS: the georeferecer module does not work Tim Sutton 2009-08-22 12:46 AM

451 Bug report Closed Low variables of translation of world files aren't bigger enough for lambert II extend Tim Sutton 2007-01-01 01:48 PM
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451 Bug report Closed Low variables of translation of world files aren't bigger enough for lambert II extend Tim Sutton 2007-01-01 01:48 PM

450 Bug report Closed Low world file without effect for .jpg or .bmp after georeferencer (helmert) good for .tif Magnus Homann 2007-01-07 02:43 PM

450 Bug report Closed Low world file without effect for .jpg or .bmp after georeferencer (helmert) good for .tif Magnus Homann 2007-01-07 02:43 PM

449 Bug report Closed Low WinQGIS: wrong interactive measures Magnus Homann 2009-08-22 12:45 AM

449 Bug report Closed Low WinQGIS: wrong interactive measures Magnus Homann 2009-08-22 12:45 AM

425 Bug report Closed Low delimited text layer and the pipe delim Tim Sutton 2009-08-22 12:46 AM

425 Bug report Closed Low delimited text layer and the pipe delim Tim Sutton 2009-08-22 12:46 AM

391 Feature request Closed Low Convert between GPX and SHAPE format Tim Sutton 2009-08-22 12:45 AM

391 Feature request Closed Low Convert between GPX and SHAPE format Tim Sutton 2009-08-22 12:45 AM

375 Bug report Closed Low georefencer turns map but don't translate it Tim Sutton 2009-08-22 12:51 AM

375 Bug report Closed Low georefencer turns map but don't translate it Tim Sutton 2009-08-22 12:51 AM

372 Bug report Closed Low Parsing Error in Add Delimted Text Plugin Tim Sutton 2009-08-22 12:46 AM

372 Bug report Closed Low Parsing Error in Add Delimted Text Plugin Tim Sutton 2009-08-22 12:46 AM

355 Feature request Closed Low WFS icon: put besides WMS icon Tim Sutton 2009-08-22 12:57 AM

355 Feature request Closed Low WFS icon: put besides WMS icon Tim Sutton 2009-08-22 12:57 AM

349 Bug report Closed Low Buffer plugin fails Gary Sherman 2009-08-22 12:46 AM

349 Bug report Closed Low Buffer plugin fails Gary Sherman 2009-08-22 12:46 AM

343 Feature request Closed Low Scale bar and measurement units should be selectable Gary Sherman 2009-08-22 12:54 AM

343 Feature request Closed Low Scale bar and measurement units should be selectable Gary Sherman 2009-08-22 12:54 AM

326 Bug report Closed Low Delimited text layer plugin: .csv extension support Tim Sutton 2009-08-22 12:46 AM

326 Bug report Closed Low Delimited text layer plugin: .csv extension support Tim Sutton 2009-08-22 12:46 AM

325 Bug report Closed Low Anti-virus crashed QGIS Tim Sutton 2009-08-22 12:46 AM

325 Bug report Closed Low Anti-virus crashed QGIS Tim Sutton 2009-08-22 12:46 AM

322 Bug report Closed Low Delimited text plugin doesn't work Tim Sutton 2009-08-22 12:46 AM

322 Bug report Closed Low Delimited text plugin doesn't work Tim Sutton 2009-08-22 12:46 AM

320 Bug report Closed Low add text layer: field selection Tim Sutton 2009-08-22 12:46 AM

320 Bug report Closed Low add text layer: field selection Tim Sutton 2009-08-22 12:46 AM

263 Bug report Closed Low GPX import: attrib table incorrect Gavin Macaulay - 2009-08-22 12:46 AM

263 Bug report Closed Low GPX import: attrib table incorrect Gavin Macaulay - 2009-08-22 12:46 AM

245 Bug report Closed Low Georeferencer plugin->Enter coordinates->Cancel does not work Tim Sutton 2009-08-22 12:46 AM

245 Bug report Closed Low Georeferencer plugin->Enter coordinates->Cancel does not work Tim Sutton 2009-08-22 12:46 AM

203 Bug report Closed Low Delimited text plugin fails on import Gavin Macaulay - 2009-08-22 12:46 AM

203 Bug report Closed Low Delimited text plugin fails on import Gavin Macaulay - 2009-08-22 12:46 AM

201 Feature request Closed Low Support usb connections to GPS's Tim Sutton 2009-08-22 12:46 AM

201 Feature request Closed Low Support usb connections to GPS's Tim Sutton 2009-08-22 12:46 AM

165 Bug report Closed Low Georeferenzierer Plugin Helmert transformation crash Tim Sutton 2009-08-22 12:46 AM

165 Bug report Closed Low Georeferenzierer Plugin Helmert transformation crash Tim Sutton 2009-08-22 12:46 AM

150 Feature request Closed Low User should be able to change the copyright text colour Gavin Macaulay - 2009-08-22 12:52 AM

150 Feature request Closed Low User should be able to change the copyright text colour Gavin Macaulay - 2009-08-22 12:52 AM

112 Bug report Closed Low Plugins are not unloaded properly Gavin Macaulay - 2009-08-22 12:46 AM

112 Bug report Closed Low Plugins are not unloaded properly Gavin Macaulay - 2009-08-22 12:46 AM

111 Bug report Closed Low scale bar in the wrong place Gavin Macaulay - 2009-08-22 12:46 AM

111 Bug report Closed Low scale bar in the wrong place Gavin Macaulay - 2009-08-22 12:46 AM

98 Bug report Closed Low Qgis 0.7.4 georeferencer does not display image from some TIFF files Tim Sutton 2007-04-05 02:05 AM

98 Bug report Closed Low Qgis 0.7.4 georeferencer does not display image from some TIFF files Tim Sutton 2007-04-05 02:05 AM
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